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Abstract 

This work deals with detecting of steady-state visual evoked potentials (SSVEP) 

generated by brain's responses to visual stimulus. The primary goal is to find a suitable 

method for the analysis and detection of  SSVEP in EEG records and to create a Matlab 

toolbox for it. Another part of this work is to verify the functionality of Matlab 

extensions and selected method of implementation while using experimentally 

measured EEG data from several different test subjects. Data were obtained 

in the laboratory, belonging to the Department of Computer Science and Engineering 

(KIV) at the Faculty of Applied Sciences. 

Abstrakt 

Tato práce se zabývá detekcí ustálených vizuálních evokovaných potenciálů (SSVEP), 

které vznikají při reakci mozku na stimulaci vizuálním podnětem. Primárním cílem je 

najít vhodnou metodu pro analýzu a detekci SSVEP potenciálů v EEG záznamech 

a vytvořit pro ni toolbox v Matlabu. Součástí práce je ověření funkčnosti rozšíření 

Matlabu a vybrané implementované metody, přičemţ jsou vyuţívána experimentálně 

naměřená EEG data od několika různých subjektů. Data byla pořízena v laboratoři, 

která náleţí Katedře informatiky a výpočetní techniky (KIV) na Fakultě aplikovaných 

věd.  
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1 Úvod 

Tato bakalářská práce je zaměřena na problematiku z oblasti neuroinformatiky. 

Neuroinformatika je vědní obor stojící na pomezí neurověd a informatiky.  

V této práci se zabývám odezvou mozku na blikající stimuly. Při této stimulaci 

vznikají SSVEP potenciály (ustálené vizuální evokované potenciály). Potenciálem 

se rozumí reakce na danou stimulaci. 

Cílem této práce je vytvořit rozšíření do prostředí Matlabu. Součástí Matlabu 

je interaktivní matlabovský toolbox EEGLAB. Rozšíření zahrnuje implementaci vhodné 

metody pro analýzu záznamů a detekci SSVEP potenciálů.  

Pro zvolení vhodné metody je nutné prostudovat základy elektroencefalografie, 

které jsou rozebrány v druhé kapitole. Ve třetí kapitole je popsána charakteristika 

a vlastnosti evokovaných potenciálů. Ne všechny známé metody jsou pro analýzu 

signálů vhodné. Jednotlivým principům metod pro analýzu signálů se věnuji v kapitole 

čtvrté. 

Závěr práce pojednává o zhodnocení dosaţených výsledků. Zhodnocení 

je zaloţeno na ověření funkčnosti rozšíření EEGLABu. Implementovaná metoda 

je pouţita při praktické analýze skutečně naměřených reálných experimentálních dat, 

které jsem získala měřením v laboratoři KIV.  
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2 Elektroencefalografie 

Elektroencefalografie je neurofyziologická a většinou neinvazivní vyšetřovací 

metoda, při které se pomocí elektrod snímají na povrchu hlavy elektrické potenciály. 

Tyto potenciály vznikají neustálou činností mozku. Amplituda potenciálů z povrchu 

kůţe lebky je velmi nízká, pohybuje se v desítkách mikrovolt [μV]. 

2.1 Elektroencefalograf 

Elektroencefalograf je zařízení, které pomocí elektrod rozmístěných na hlavě 

subjektu zaznamenává aktivitu mozkových neuronů. Skládá se ze snímacích elektrod, 

zesilovače a procesoru. Spojení dvou elektrod a zesilovače představuje tzv. svod. 

Zesilovače pouţívané v EEG mají 2 vstupy a fungují diferenčně. Odečítají 

od sebe signály přiváděné na vstupy. Data se po zesílení zpracovávají a převádí 

do křivek. Takto získaný záznam se nazývá elektroencefalogram (zkráceně EEG). 

Ukázka záznamu EEG je vyobrazena na obrázku 2.1. 

 

Obrázek 2.1: Příklad 18-ti kanálového záznamu EEG [1] 

 

 



3 
 

Signál EEG odráží mozkovou aktivitu – různé fáze spánku a jeho poruchy, stavy 

vědomí, projevy metabolických poruch, vlivy drog či toxických látek. 

Elektroencefalografická vyšetření se v praxi běžně provádějí u všech poruch funkce 

mozku v neurologii a v převážné většině případů i v psychiatrii. [1] 

 2.2 Elektrody a jejich rozmístění 

Jednou z moţností, jak zjistit mozkovou aktivitu, je vyuţití invazivní  

metody - elektrokortikografie (ECoG), při které je aktivita činnosti mozku snímána 

přímo z povrchu mozkové kůry. Tento druh snímání EEG aktivity se pouţívá výhradně 

v medicínské praxi. Elektrokortikografie je přesnější neţ elektroencefalografie, jelikoţ 

u snímání nedochází k zeslabení signálu průchodem přes lebku. Při této metodě jsou 

pouţity podpovrchové elektrody. Mohou být v podobě drátků, jehel nebo terčíků 

z vhodného materiálu (Pt, Ag-Cl, a jiné). Vyuţít lze také bavlněné knoty v roztoku soli. 

Další moţností je pouţití povrchových elektrod (viz obrázek 2.2). Povrchové 

elektrody slouţí k neinvazivnímu snímání elektrické aktivity mozku z povrchu hlavy. 

Pouţívají se zlacené elektrody nebo elektrody stříbrné s vrstvou AgCl v kombinaci 

s roztoky, které sniţují přechodový odpor (přesycený fyziologický roztok), 

popř. elektrodovými gely a pastami s volnými zápornými ionty Cl. Pouţívají se buď 

jednotlivé elektrody nebo elektrodové čepice, ve kterých jsou jiţ zafixovány EEG 

elektrody v systému „10-20“. [2] 

 

 

Obrázek 2.2: Povrchové elektrody [3] 
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Systém 10-20 rozmístění elektrod (viz obrázek 2.3) je zaloţen na vztahu mezi 

pozicemi elektrod a pod nimi leţící mozkovou kůrou. Elektrody jsou rozmístěny 

rovnoměrně na povrch lebky. Pozice jednotlivých elektrod jsou definovány podle 

poměru 10-20% mezi kořenem nosu a týlní jamkou a mezi ušními lalůčky. 

Jednotlivé elektrody jsou označené podle mezinárodní normy, a to podle 

počátečního písmene umístění elektrod. Jedná se o označení z angličtiny F (frontal), 

Fp (frontpolar), T (temporal), C (central), P (parietal) a O (occipital). Jednotlivá čísla 

představují levou a pravou hemisféru. Sudá čísla (2, 4, 6, 8) náleţí pozicím nad pravou 

hemisférou, lichá čísla (1, 3, 5, 7) nad levou hemisférou (čím menší hodnota, tím blíţe 

ke středu). Elektrody mezi oběma hemisférami, tzn. ţe se nacházejí v centrální linii 

hlavy, jsou označené písmenem z. [4] 

 

Obrázek 2.3: Systém 10-20 rozmístění EEG elektrod [1] 

2.3 Rytmy EEG 

Na EEG záznamu můţeme odlišit několik základních rytmů - alfa, beta, delta, 

théta a gama. Kaţdé z těchto pásem odpovídá určitému specifickému druhu mozkové 

činnosti. Označují se řeckými písmeny a mají různou frekvenci a amplitudu.  
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 Pásmo delta odpovídá frekvenci pod 4 Hz, má proměnnou amplitudu pohybující 

se v rozmezí 10 – 300 µV. Toto pásmo představuje výrazný útlum všech funkcí. 

Je projevem bezesného spánku nebo stavu bezvědomí. Dochází k regeneraci ţivotních 

funkcí, k akumulaci energie a k pomalé látkové přeměně. U dětí ve věku do jednoho 

roku se vyznačuje málo pravidelnou aktivitou. V případě, ţe se pásmo delta vyskytne 

mimo fázi spánku, jedná se o patologický jev. Ukázka vlny delta je na obrázku 2.4. 

 

Obrázek 2.4: Vlna delta 

 Pásmo théta odpovídá frekvenci 4 - 8 Hz, je charakterizováno rovněţ útlumem všech 

funkcí, nedochází k ţádným odezvám na smyslové podněty, můţe docházet k tvorbě 

obrazových informací v podvědomí a k tvorbě snů (slabá radiace vln alfa a beta). Pásmo 

théta je typické především pro ospalost, usínání, hluboké uvolnění, ale také pro poruchy 

pozornosti a lehkou mozkovou dysfunkci. Ukázka vlny théta je na obrázku 2.5. 

 

Obrázek 2.5: Vlna théta 

 Pásmo alfa je aktivita o frekvenci 8 - 13 Hz, amplituda se pohybuje mezi  

30 a 50 µV. Toto pásmo vyjadřuje stav bez napětí a nedochází k reakcím na vnější 

podněty ani k soustředěnému myšlení. Pásmo alfa vyjadřuje stav naprosté bdělosti 

doprovázené příjemnými pocity. V tomto stavu se posilují a regenerují všechny ţivotní 

funkce. Jedná se o relaxaci, odpočinek a bdění se zavřenýma očima. Tento stav mizí 

následně po otevření očí a při soustředění pozornosti na nějaký problém. Pásmo alfa 

představuje základní pásmo u dospělých jedinců. Ukázka vlny alfa je na obrázku 2.6. 
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Obrázek 2.6: Vlna alfa 

 Pásmo beta odpovídá frekvenci 14 - 30 Hz, amplituda se pohybuje v rozpětí  

5 aţ 30 µV. Pásmo beta převládá při otevřených očích, soustředění se, přemýšlení 

a kognitivní činnosti. Představuje smyslové soustředění na okolí, akceschopnost 

a napětí. V případě, ţe se pásmo beta objeví při zavřených očích, jedná se o stav 

náladových změn, podráţděnost, nejistotu a úzkost. Toto pásmo také charakterizuje 

pohyb. Ukázka vlny beta je na obrázku 2.7. 

 

Obrázek 2.7: Vlna beta 

 Pásmo gama o frekvenci 30 Hz a více vyjadřuje extrémní soustředění nebo hlubokou 

meditaci. Amplituda se pohybuje přibliţně kolem 10 µV. Ukázka vlny gama je 

na obrázku 2.8. 

 

Obrázek 2.8: Vlna gama 

V této podkapitole jsem čerpala z [5] a [6]. 
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2.4 Artefakty 

V záznamu EEG se kromě EEG signálu vhodného k analýze mohou projevit také 

jevy, které nemají vztah ke snímanému signálu a působí tedy rušivě. Jsou definované 

jako grafoelementy, které nejsou způsobené elektrickou aktivitou mozku. Takové jevy 

jsou označovány jako artefakty a jsou způsobeny fyziologickými a vnějšími vlivy. 

Vyskytují se zcela běţně a v praxi je lze jen těţko omezit, komplikují však 

vyhodnocování výsledků naměřených dat, a proto je nutné je ze záznamu odstranit. 

Zjednodušeně je lze rozdělit do tří základních kategorií – artefakty z prostředí, 

artefakty z EEG přístroje a artefakty, které pocházejí od pacienta (biologické 

či fyziologické artefakty). [7], [10] 

2.4.1 Artefakty z prostředí 

Jedná se o takové artefakty, které vznikají na základě interference se zdroji 

elektrické energie nebo jiného elektromagnetického pole z bliţšího či vzdálenějšího 

okolí EEG přístroje. 

Artefakt ze střídavého proudu (viz obrázek 2.9) můţe ovlivnit EEG záznam 

v případě, jsou-li v okolí EEG přístroje přítomné zdroje silného elektromagnetického 

pole. Nejčastější příčinou je rozdíl v impedancích jednotlivých elektrod. Na elektrodách 

s různou impedancí se indukují různá napětí, jejich diference je zesílená a smíšená 

s bioelektrickým signálem. Artefakt ze střídavého elektrického proudu má typickou 

frekvenci 50 Hz v Evropě a 60 Hz v USA.  

EEG záznam mohou ovlivnit i artefakty z okolních přístrojů s jinou frekvencí, 

neţ je střídavý proud (zvonění telefonu, zapnutí a vypnutí osvětlení, činnost 

signalizačních systémů, ventilačních přístrojů, infuzních souprav). Na EEG záznam 

můţe mít velký vliv také pohyb dalších osob v místnosti. [7] 

2.4.2 Artefakty z EEG přístroje 

Mezi nejběţnější artefakty z EEG přístroje se řadí elektrodové artefakty. Častý 

je elektrodový popping, jehoţ podstatou je náhlá změna přechodové impedance 

elektrod. 
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Mezi artefakty v této skupině patří dále například artefakty z nesprávně umístěné 

EEG čepice, z kabelů mezi elektrodami a zařízením EEG, nízká kvalita elektrod 

(viz obrázek 2.9) nebo artefakty, které jsou způsobené poruchami adaptéru nebo EEG 

přístroje. [7] 

 

 

Obrázek 2.9: Ukázka artefaktu z prostředí a ze špatné elektrody [8] 

2.4.3 Artefakty pocházející od pacienta 

Mezi biologické artefakty (viz obrázek 2.10) se řadí veškeré rušivé jevy 

pocházející přímo od měřeného subjektu. 

Řadí se mezi ně oční artefakty z mrkání, třes víček, dále oční artefakty z bulbů, 

kde maximum těchto artefaktů je v F svodech (Fp1 a Fp2 pro vertikální pohyby, F7 a F8 

pro horizontální pohyby). Svalové artefakty mají krátké trvání a ostrý tvar. Pohybové 

artefakty jsou často rytmické. Artefakty z pocení mají vysokou amplitudu a nízkou 

frekvenci (kolem 0,5 Hz). V záznamu se mohou jako další biologické artefakty objevit 

artefakty dentální (jedná se o měření subjektů se zubními výplněmi, které jsou tvořeny 

z různých materiálů), tepová a srdeční činnost, elektrické projevy kardiovaskulární 

soustavy, artefakty z ORL oblasti vznikající např. při ţvýkání, mluvení, polykání, při 

kašli a podobně. [7] 

 

 

Obrázek 2.10: Ukázka biologických artefaktů [8] 
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3 Evokované potenciály 

Evokované potenciály (EP) jsou generované mozkem jako reakce nervové 

soustavy na vnější stimulaci. Existuje nekonečná řada podnětů, na které nervový systém 

reaguje evokovanou odpovědí (např. poklep kladívka, silnější dotek na kůţi, bolestivý 

vjem, náhlá změna teploty, dále náhlá emoce, apod.). EP snímané ze skalpu mají nízkou 

amplitudu, odpovídají velikosti řádově mikrovoltů (1-20 µV), jsou tedy mnohonásobně 

niţší neţ EEG a artefakty.  

Podle typu stimulace se rozlišují EP vizuální, sluchové kmenové, 

somatosenzorické, motorické a endogenní kognitivní (viz obrázek 3.2). [9] 

3.1 VEP – vizuální evokované potenciály 

K vyšetření VEP je potřeba zařízení, které dokáţe vyvolat optické podněty. Jako 

vlastní generátor optických podnětů často slouţí zvláštní monitor, LED diody, 

stroboskop, zrcadlový systém nebo polokoule slouţící ke stimulaci záblesky 

(tzv. Ganzfeld stimulátor). 

Podstata stimulace zrakové dráhy zábleskem spočívá ve změně jasu v zorném 

poli. Podstata stimulace strukturovaným podnětem spočívá ve vyuţívání obrazců 

s tmavými a světlými plochami. Tato stimulace můţe probíhat objevením obrazce, jeho 

zmizením nebo nejčastěji pouţívanou záměnou dvou vzájemně obrácených 

a doplňujících se vzorů (viz obrázek 3.1). Podnětem je změna kontrastu v různých 

částech zorného pole, přičemţ celková hodnota jasu zůstává stejná. Jednoznačnou 

výhodou monitoru je především moţnost jednoduché změny parametrů stimulačního 

obrazce (čtverce, pruhy, jejich velikost a orientace a podobně) a snadná dostupnost. [9] 

 

Obrázek 3.1: Ukázka možného stimulu VEP – šachovnice [12] 
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Výsledný záznam mohou ovlivnit některé technické parametry stimulace, jako např.:  

 luminance stimulační plochy 

 kontrast mezi prvky 

 frekvence stimulace 

 velikost stimulační plochy 

Nejen velikost stimulační plochy, ale i velikost jednotlivých prvků stimulačního 

vzorce má zásadní vliv na výsledný záznam. Při pouţití šachovnice záleţí na zvolené 

velikosti čtverců. Při jejich zmenšování se zmenšuje také amplituda a dochází 

k prodluţování latencí vln. Čím menší je velikost čtverců, tím větší je citlivost vyšetření 

k poruchám zrakové dráhy. Výsledek však můţe být ovlivněn sníţenou zrakovou 

ostrostí, která můţe nastat např. při špatně korigované oční vadě. Při výrazném zvětšení 

čtverců je záznam velmi podobný záznamu při stimulaci zábleskem. 

Vyšetření zrakové dráhy se provádí nejčastěji u pacientů se zánětem zrakového 

nervu či u jiných poruch zraku nejasné příčiny. [9], [11] 

3.1.1 SSVEP – ustálené vizuální evokované potenciály 

Ustálené vizuální evokované potenciály jsou speciální formou VEP. Jako SSVEP 

se označuje reakce na pravidelně se opakující vizuální podnět o konstantní frekvenci 

přibliţně v rozmezí 4 aţ 100 Hz. Vznikají periodické sinusové vlny o stejné frekvenci, 

jakou je stimulována sítnice. Reakce je ovlivněná typem i frekvencí stimulace. Bylo 

zjištěno, ţe reakce vyvolané blikajícími diodami byly větší, neţ stimulace 

obdélníkovým podnětem na obrazovce počítače.  

Prezentace stimulů na monitoru je také velmi omezena z hlediska rozsahu 

frekvencí, které mohou být pouţité pro stimulaci. Obnovovací frekvence monitoru, 

tzn. kolikrát je monitor schopný překreslit obrazovku za jednu sekundu, je niţší 

neţ 100 Hz. Pro LCD monitory je obnovovací frekvence obvykle 60 Hz.  

Stimulační frekvence pro detekci SSVEP se volí v kmitočtovém pásmu 

5 aţ 75 Hz. Frekvence se rozdělují do tří pásem. Nízké frekvence jsou do 12 Hz, střední 

v rozsahu 12 aţ 30 Hz a vysoké nad 30 Hz. Frekvence 15 aţ 25 Hz představuje vyšší 

riziko vyvolání epileptického záchvatu.  

Barva stimulu také ovlivňuje SSVEP (na rozdíl od VEP). Červené, ţluté a modré 

světlo má různé účinky na SSVEP v kombinaci s danou frekvencí. Červené světlo 
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vyvolává nejsilnější odezvu při stimulační frekvenci 11 Hz. Modré světlo má mírně 

slabší odezvu neţ světlo červené a nejsilnější odezvu má přibliţně kolem 13 Hz. 

Je méně závislé na frekvenci. Ţluté světlo má ještě niţší amplitudu neţ modré a také 

je méně závislé na dané frekvenci. [13] 

3.2 BAEP – sluchové kmenové evokované potenciály 

Sluchovou dráhu je moţné stimulovat různě, přičemţ se stimuly liší podle délky 

trvání a frekvenčních charakteristik.  

Nejčastějším stimulem je tzv. klik. Jedná se o záměrně nestrukturovaný zvukový 

podnět, který nemá stálou tónovou frekvenci.  

Dalším stimulačním podnětem můţe být tzv. „burst“ (zapraskání), který má 

na rozdíl od kliku určitou strukturu. Náběh intenzity a její pokles probíhá na velmi 

krátkém časovém úseku. Základním stimulačním parametrem, který má vliv 

na pořízený záznam, je intenzita stimulace. 

Vyšetření je vhodné pro pacienty se závratí, s hučením v uších nebo u pacientů 

s podezřením na nádor sluchového nervu. [9], [11]  

3.3 SEP – somatosenzorické evokované potenciály 

Pomocí SEP se vyšetřují senzitivní dráhy (vedení citlivosti z končetin přes míchu 

do mozkové kůry).  

Standardizovaným způsobem stimulace je stimulace elektrická. Elektrický 

stimulátor generuje krátký elektrický výboj, který je bipolární stimulační elektrodou 

aplikován na zvlhčenou kůţi končetiny nad průběhem stimulovaného nervu. Standardní 

místa pro stimulaci jsou v zápěstí, těsně za karpálním tunelem, a za vnitřním kotníkem 

nohy. 

Vyšetření se provádí u pacientů s postiţením míchy, s roztroušenou sklerózou 

či u neurodegenerativních onemocnění. [9], [11] 

3.4 MEP – motorické evokované potenciály 

U motorických EP se pouţívá elektrická stimulace nebo magnetická stimulace. 

Magnetický stimulátor generuje krátkodobý magnetický impuls přes magneto-
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elektrickou cívku, která se přikládá nad stimulovanou část nervové soustavy. Lze 

stimulovat periferní nervy a především nebolestivě mozkový kortex.  

Vyšetření se provádí především u centrálních poruch hybnosti, u roztroušené 

sklerózy a u neurodegenerativních onemocnění. [9], [11] 

3.5 ERP – endogenní kognitivní evokované potenciály 

Stimulace při vyšetření ERP je velmi individuální. Tato stimulace je většinou 

vytvářena pro experimentální podmínky.  

Standardizovaným testem je vyšetření vlny P3 ve sluchovém paradigmatu. 

Při tomto testování se pouţívá zvukový stimulátor generující dva druhy tónů, které mají 

odlišnou kvalitu. Stimulátor musí mít moţnost zvolení střídavé frekvence různých tónů 

a moţnost jejich náhodného výběru. [9] 

 

Obrázek 3.2: Evokované potenciály (SSEP, BAEP, VEP, ERP) [14] 
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4 Metody analýzy signálů  

Pro vyhodnocování signálů se pouţívají různé metody analýzy signálů. Metody 

analýzy signálů se dělí do tří částí. První je analýza signálů v časové oblasti, druhá 

ve frekvenční oblasti a třetí v oblasti časově frekvenční. Volba příslušné oblasti závisí 

na typu analyzovaného signálu a na poţadovaném výsledku. 

Analýza signálů v časové oblasti zahrnuje především statistickou analýzu, výpočet 

a analýzu korelačních funkcí, koherence, analýzu střední, maximální a minimální 

hodnoty v závislosti na čase, třídicí metody a podobně. 

Spektrální analýza je nástrojem k popisu signálu pomocí jeho sloţek 

ve frekvenční oblasti. Matematický výpočet spektrální výkonové hustoty náhodných 

signálů můţe být nepřesný, nejednoznačnost výsledků spektrální analýzy můţe ovlivnit 

charakter signálu i výběr vhodné metody. 

Metody spektrální analýzy se rozdělují do tří skupin: 

 Neparametrické metody zaloţené na diskrétní Fourierově transformaci. 

Vyznačují se tím, ţe se při jejich pouţití nevytvářejí ţádné modely vzniku 

a predikce signálu, při analýze se vyuţívají jen změřená data. Do této skupiny 

metod se řadí například Fourierova transformace, diskrétní Fourierova 

transformace, rychlá Fourierova transformace, Z-transformace a spektrální 

výkonová hustota. 

 Parametrické metody vyuţívají popisu signálů pomocí vypočtených parametrů. 

Základem je vytvoření modelu vzniku signálu. Metody dosahují lepších výsledků 

v případě, ţe jsou data danému modelu velmi blízká. Mezi nejznámější modely 

dat patří autoregresní model (AR), model klouzavých průměrů (MA), autoregresní 

model klouzavých průměrů (ARMA). Všechny tyto tři modely aproximují 

skutečné spektrum signálu pomocí kvadrátu modulu frekvenční charakteristiky 

lineárního časově invariantního (LTI) filtru. Stupeň aproximace je závislý 

na volbě řádu filtru (řádu modelu). 
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Časově frekvenční transformace jsou uplatněny zejména při  analýze 

elektroakustických systémů, řečových a hudebních signálů. Jsou vhodné ke zpracování 

signálů z oblasti lékařské diagnostiky, jako je např. EEG a EKG. Vyuţívají se tam, 

kde je potřeba frekvenční analýzu provádět i v závislosti na čase.  

Analýza signálů v časově frekvenční oblasti se rozděluje na dva základní druhy metod 

(viz obrázek 4.1): 

 Lineární, kde jejich základním principem výpočtu je rozklad analyzovaného 

signálu na elementární časově frekvenční jednotky. Jejich předností je zejména 

rychlost výpočtu.  

 Nelineární, jejich jistou nevýhodou je časová náročnost výpočtu a nároky 

na HW počítače. 

 

 

 

Obrázek 4.1: Rozdělení časově frekvenčních postupů pro analýzu signálů 

V této kapitole jsem čerpala z [15]. 
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4.1 Fourierova transformace  

Pro převod z časové do frekvenční oblasti je nejpouţívanější Fourierova 

transformace (FT). Pro spojitou funkci je definována integrálními rovnicemi. 

Pro přímou transformaci platí vztah: 

                                           ∫     
  

  
         ,                           (4.1.1) 

pro zpětnou transformaci platí: 

                                           ∫     
  

  
        ,                             (4.1.2) 

kde f je frekvence, t čas, x(t) signál v časové oblasti, k jsou konstanty a X(f) představuje 

reprezentaci signálu ve frekvenční oblasti. [15] 

4.2 Diskrétní Fourierova transformace 

Je-li zpracovávána diskrétní datová posloupnost, je nutné upravit výše uvedené 

integrální rovnice (4.1.1) a (4.1.2). Pro přímou transformaci platí: 

                             
 

 
 ∑     

   
   

 
         

         
 

 
 ∑     

   
    

 
    

   ,          (4.2.1) 

pro zpětnou transformaci platí: 

                                                           ∑    
   
      

    

 
 
,                                     (4.2.2) 

kde    je hodnota n-tého prvku diskrétní posloupnosti,    je k-tá frekvenční sloţka 

signálu, T doba trvání realizace, N počet prvků posloupnosti a j představuje imaginární 

jednotku. 

Na základě výše uvedených definičních vztahů lze spočítat hodnoty diskrétní 

Fourierovy transformace (DFT), algoritmus je ale velmi náročný na počet paměťových 

polí i počet matematických operací. Proto byly vyvíjeny algoritmy, které by byly 

výpočetně a časově úspornější. Nalezení rychlého algoritmu výpočtu DFT bylo v roce 

1965 zásadním vývojovým krokem v číslicovém zpracování signálů. [15] 
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4.3 Rychlá Fourierova transformace 

Rychlou Fourierovou transformací (FFT) získáme stejné výsledky jako 

při výpočtu DFT. Rozdíl spočívá ve výrazném sníţení doby potřebné k výpočtu. FFT 

potřebuje pouze O(N log N) operací, zatímco  DFT O(  ). Podstatou rychlých 

algoritmů je převod na součin řídkých matic. To má za následek redukci počtu 

potřebných matematických operací. 

Algoritmus Cooleyho a Tukeyho pouţívá decimaci v čase. Je nejpouţívanější 

variantou FFT algoritmu. Rekurzivně dělí DFT s velikostí sloţeného čísla do menších 

DFT o velikostech N1 a N2. Je příkladem rozděl a panuj algoritmu. 

Algoritmus: 

1) Vstupní sekvence o N vzorcích se doplní tak, aby nová délka sekvence byla 

nejbliţší větší mocninou čísla 2. Například sekvence o délce 500 se doplní na 512. 

2) Proces časové decimace způsobí, ţe se změní pořadí vstupních vzorků. Například 

pro 8 vzorkový signál je původní pořadí vzorků 0, 1, 2, 3, 4, 5, 6, 7, po procesu 

časové decimace je pořadí 0, 4, 2, 6, 1, 5, 3 a 7. Vztah mezi pořadím vzorků lze 

jednoduše vyjádřit pomocí otočení binární vstupní posloupnosti (viz obrázek 4.2). 

 

Obrázek 4.2: Princip změny pořadí vstupních vzorků, N = 8 bodů  

3) Z takto upravené posloupnosti se vypočítá (N/2) posloupností o délce 2. 

4) Dále se vypočítá z 2-bodových posloupností nových (N/4) posloupností o délce 4. 

5) V tomto kroku se vypočítá (N/8) nových posloupností o délce 8. 

6) Postup se nadále opakuje aţ do doby, dokud není výsledkem jediná posloupnost 

délky N. 
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Ukázka blokového diagramu pro výpočet FFT o vstupní 8 bodové posloupnosti je 

na obrázku 4.3. 

 

Obrázek 4.3: Příklad blokového diagramu pro výpočet FFT, N = 8 bodů  

V této podkapitole jsem čerpala z [16] a [17]. 

4.4 Spektrální výkonová hustota 

Vyhodnocování náhodných signálů je vhodné provádět pomocí výpočtu spektrální 

výkonové hustoty (PSD – Power Spectral Density). PSD se pouţívá k odhadu spektra 

vzorkovaného signálu s konečnou délkou a udává závislost rozloţení hustoty výkonu 

signálu na frekvenci v Hz. 

Často se pro určení PSD vyuţívá metod (přímých a nepřímých) zaloţených 

na pouţití diskrétní Fourierovy transformace. 

Nepřímou metodou se PSD určí pomocí Wiener – Chinčinova teorému,  odhad 

PSD je určený diskrétní Fourierovou transformací autokorelační funkce: 

                                 ∑        
         

   ,                                 (4.4.1) 

kde Rxx(n) je autokorelační funkce. 

Přímou metodou se rozumí moderní verze Schusterova periodogramu. Odhad 

PSD je počítaný jen pro vzorky segmentu x0, x1 až xN-1 a lze jej vyjádřit jako: 
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|∑               

   |
 
.                             (4.4.2) 

Výsledky získané pouţitím přímé i nepřímé metody pro výpočet PSD jsou 

naprosto totoţné. Z kaţdého jednotlivého okna je takto získáno okamţité výkonové 

spektrum (periodogram, spektogram). 

V případě, ţe je analyzovaný signál dostatečně dlouhý, pouţívá se pro získání 

vyhlazeného odhadu některá z metod průměrování dílčích periodogramů. 

Nejpouţívanější metodou průměrování periodogramu je Welchova metoda. Její princip 

je ukázán na obrázku 4.4. 

 

Obrázek 4.4: Princip Welchovy metody 

Welchova metoda je zaloţená na redukování rozptylu periodogramu rozdělením 

vstupních dat x(n) na K segmentů, přičemţ kaţdý takový segment má délku M vzorků. 

Segmenty se překrývají, překrytí je 50 - 75 %. Kaţdý segment je násoben M vzorkovým 

oknem w(n). U této metody je moţné zvolit různé typy oken, nejčastěji se pouţívá 

Hammingovo a Hannovo okno. Dále se odhadne PSD kaţdého segmentu – PSDi(k). 

Výsledný odhad PSD se získá zprůměrováním všech dílčích k periodogramů. 

Podobně jako Welchova metoda funguje i metoda Bartlettova, rozdíl je pouze 

v nepřekrývajících se segmentech a nenásobení segmentů oknem w(n).  

V této podkapitole jsem čerpala z [17]. 

4.5 Krátkodobá Fourierova transformace 

Krátkodobá Fourierova transformace (STFT) patří k časově frekvenčním 

postupům slouţícím ke zpracování naměřených signálů. Poskytuje kompromis mezi 

časovou a frekvenční reprezentací signálů. Je lineární a obecně komplexní transformace. 

STFT lokalizuje frekvenční sloţky v čase s lineárním rozlišením. Základem STFT 

je rozdělení signálu na dostatečně malé realizace, u kterých je moţné předpokládat, 

ţe budou dostatečně stacionární, tzn. ţe parametry signálu jsou konstantní a nezmění se 

v určitém časovém úseku.  
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Rozdělení je provedeno multiplikací okénkové funkce a signálu. Na kaţdém 

takovém výřezu se provede FT. Okénko se postupně posouvá v čase.  Definiční integrál 

STFT je vyjádřen jako: 

                                ∫ [             ]
  

  
         ,                  (4.5.1) 

kde g je okénková funkce, t je čas,      je komplexní konjunkce,   časové posunutí 

okénka, x(t) časová reprezentace signálu a STFT (     vyjadřuje časově frekvenční 

reprezentaci signálu. 

Zpětnou transformací lze realizovat rekonstrukci signálu. Platí vztah: 

                         
 

  
∫ ∫                   

  

  
         

  
     .          (4.5.2) 

V této podkapitole jsem čerpala z [15]. 

4.6 Waveletová transformace 

Waveletová transformace (WT, v české literatuře je někdy označovaná jako 

vlnková transformace) patří mezi časově frekvenční transformace a obsahuje informaci 

o časové lokalizaci spektrálních sloţek. 

 Na rozdíl od sinu a cosinu, které se pouţívají jako bázové funkce u FT, nejsou 

wavelety periodické funkce, ale jsou to funkce, které jsou nenulové pouze na určitém 

časovém úseku. 

Hlavní myšlenka vlnkové transformace spočívá ve vhodné změně velikosti okna. 

Vhodnou volbou šířky okna a tvarem bázové funkce lze dosáhnout optimálního poměru 

rozlišitelnosti v čase a frekvenci. Pro nízké frekvence je okno širší, pro vysoké 

frekvence uţší.  

Čerpala jsem z [18] a [19]. 
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4.6.1 Spojitá waveletová transformace 

Spojitá waveletová transformace (CWT) je definována integrální rovnicí  

                                                           ∫          
  

  
                                      (4.6.1) 

                                                              
 

√| |
  (

   

 
),                                       (4.6.2) 

kde   je časové posunutí, s je měřítko,   je transformační vlnková funkce, x(t) je 

analyzovaný signál a WT      představuje waveletovou transformaci. 

Substitucí rovnice (4.6.2) do rovnice (4.6.1) vznikne následující vztah (4.6.3), 

který reprezentuje korelaci mezi vstupním signálem x(t) a vlnkovou funkcí  . 

                                                     
 

√| |
 ∫       (

   

 
)

  

  
  .                        (4.6.3) 

Algoritmus pro výpočet CWT:  

1) Vybere a nastaví se vhodná vlnková funkce. 

2) Vlnková funkce se porovná s analyzovaným signálem. Vypočítá se koeficient 

shody, čím je koeficient větší, tím je při daném posunutí a měřítku větší shoda 

vybrané vlnkové funkce se signálem. 

3) Vlnková funkce se posune vzhledem k signálu (časové posunutí) a opakuje 

se krok 2. Tento krok se provádí pro všechna časová posunutí. 

4) Změní se měřítko waveletu (realizuje se roztaţení vlnkové funkce) a opakují se 

kroky 2 a 3. Opakování je provedeno pro všechna měřítka. 

Často pouţívanými vlnkovými funkcemi CWT jsou wavelety typu Morlet 

(Morletova vlnka) a Maxican hat (Mexický klobouk, v některé literatuře je také někdy 

označován jako Mexické sedlo). Jejich tvar je blízký sinusovým vlnám. 

Wavelet typu Morlet (viz obrázek 4.5) je definován jako výsledek kompromisu 

mezi Fourierovou transformací a polohovou lokalizací jednorázových dějů. Mezi 

vlastnosti této funkce patří symetričnost, komplexnost, není ortogonální, a tudíţ nelze 

pouţít pro DWT, je vhodná pro CWT. Vzorec: 

                              
 

 
  

                   .                            (4.6.4) 
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Obrázek 4.5: Wavelet typu Morlet 

Wavelet typu Mexican hat (viz obrázek 4.6) je definován jako druhá derivace 

Gaussovy pravděpodobnostní funkce. Vlastností této funkce je symetričnost, není 

ortogonální, je vhodná pro CWT. Vzorec: 

                                                            
 

√ 
  

 

               
 .                       (4.6.5) 

 

Obrázek 4.6: Wavelet typu Mexican hat 

Wavelety typu Daubechies (vlnky Daubechies) zastupují mnoţinu vlnek různého 

řádu, které nemají explicitní vyjádření     . Tato funkce je asymetrická, je vhodná 

pro CWT i DWT (diskrétní WT) a je ortogonální. Vlnkové funkce typu Daubechies 

a některé další známé wavelety jsou uvedeny v příloze A. 

V této podkapitole jsem čerpala z [15] a [19]. 
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5 EEG měření 

Během bakalářské práce jsem provedla experiment u 3 osob, přičemţ mým cílem 

bylo získat vhodná data pro analýzu a detekci SSVEP potenciálů. 

5.1 Postup měření  

Kaţdá testovaná osoba musela být před samotným měřením bezpodmínečně 

seznámena s průběhem získávání dat a s tím spojenými moţnými zdravotními riziky. 

Jelikoţ měření můţe vést ke zhoršení zdravotního stavu některých nemocí – např. 

epilepsie, nesmí měřená osoba těmito nemocemi trpět. 

Pro správné měření bylo nezbytné zajistit vhodné testovací podmínky 

(rozsvícené/zhasnuté světlo v testovací kabině, teplota v místnosti, ale také vyvarování 

se situací, které mohou ovlivnit subjekt, a tak i naměřená data – např. přílišné světlo, 

hluk, stres, svalové napětí, …). 

Dále bylo nutné vybrat správnou velikost EEG čepice (velikosti jsou uvedeny 

na čepici) a přesně ji umístit na hlavu subjektu. Pro měření byla pouţita čepice 

s elektrodami rozmístěnými podle mezinárodního standardu 10-20 (viz obrázek 5.1). 

 

 

Obrázek 5.1: EEG čepice s rozmístěním elektrod 10 -20 [20] 
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Testované osobě byla očištěna kontaktní místa (uši, čelo) a na ně umístěny 

elektrody potřené gelem. Následně byl gel aplikován injekční stříkačkou pod čepici tak, 

aby došlo ke kontaktu s pokoţkou.  

Po přemístění subjektu do zvukotěsné komory a připojení bylo nutné sledovat 

na monitoru, zda je kontakt dostatečný, v případě potřeby se doplnil gel. Nakonec byla 

testovaná osoba uzavřena v kabině a byl proveden experiment na základě stimulačního 

scénáře. 

5.2 Stimulační scénář experimentu  

Ke stimulaci subjektů jsem pouţila panel s červenými diodami. Měřená osoba 

byla stimulována vhodnou frekvencí a byl pořízen záznam.  

U subjektů 1, 2 a 3 byly záznamy získány pouţitím stimulačních frekvencí 5, 7, 9 

a 11 Hz. U subjektu 4 jsem vyzkoušela i některé jiné stimulační frekvence – 8, 9, 10, 14 

a 15 Hz.   

Kaţdý záznam z měření 1, 2 a 6 obsahuje 60 sekund dat, při kterých byl subjekt 

v klidovém stavu, a 60 sekund dat, při kterých byl subjekt stimulován blikajícím 

panelem.  

Záznamy v měření 3 byly pořízeny pro stejný subjekt jako v měření 1 (pouze v jiný 

čas). Tyto záznamy obsahují 120 sekund dat, při kterých byl subjekt stimulován. Data 

naměřená v klidovém stavu pouţívám z měření 1. 

Veškeré naměřené záznamy jsou na přiloţeném CD. 

5.3 Naměřená data 

Naměřená data byla pořízena softwarem Brain Vision Recorder. Kaţdý naměřený EEG 

záznam obsahuje 3 soubory: 

 Binární soubor .eeg – obsahuje nezpracovaný záznam mozkové aktivity 

na jednotlivých kanálech.  

 Hlavičkový textový soubor .vhdr  - obsahuje obecné informace o naměřených 

datech, např. počtu kanálů či intervalech vzorkování (viz obrázek 5.2). 

 Textový soubor .vmrk – obsahuje značky (markery) v záznamu (viz obrázek 5.3). 
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Obrázek 5.2: Ukázka souboru .vhdr 

 

Obrázek 5.3: Ukázka souboru .vmrk 
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6 EEGLAB 

EEGLAB je široce pouţívaný, interaktivní Matlabový toolbox pro zpracování 

elektrofyziologických dat a jejich vizualizaci. Je závislý na platformě Matlab. 

University of California v San Diegu EEGLAB volně poskytuje ke staţení 

na internetové adrese <http://sccn.ucsd.edu/eeglab/>. 

6.1 Interaktivní grafické uživatelské rozhraní 

EEGLAB poskytuje interaktivní grafické uţivatelské rozhraní (GUI, viz obrázek 

6.1), které umoţňuje uţivatelům flexibilně a interaktivně zpracovávat 

elektrofyziologická data. GUI je jednodušeji pouţitelné pro nové uţivatele 

a při zkoumání nových dat. Po načtení dat jsou zobrazeny informace např. o počtu 

kanálů, délce signálu, vzorkovací frekvenci nebo velikost dat v MB. 

Všechny funkce dostupné v GUI jsou rovněţ přístupné také pomocí příkazového 

okna. Vyuţít lze psaní jednotlivých příkazů nebo vyvolání přímo některé jiţ definované 

pop funkce (viz dále). 

 

 

 

Obrázek 6.1: GUI EEGLABu v13.1.1 

 

http://sccn.ucsd.edu/eeglab/
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Uţivatelé mohou importovat mnoho různých datových formátů, například ASCII, 

MATLAB, BCI2000, Neuroscan, Biosemi nebo BrainVision. Dále lze provádět 

předzpracování dat. Mezi standardní metody pro předzpracování dat jsou v EEGLABu 

k dispozici například filtry (FIR a IIR), extrakce epoch či vzorkování. Uţivatelé mohou 

provádět analýzy dat a následně data vizualizovat.  

6.2 Struktura EEG dat 

Všechny informace o aktuálně načtených testovacích datech obsahuje proměnná 

EEG v EEGLABu a zobrazí se zadáním příkazu >>EEG do příkazového okna (viz 

obrázek 6.2). 

 

Obrázek 6.2: Struktura EEG dat 
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Setname obsahuje název zadaný uţivatelem při načítání dat, dále v comments lze 

najít umístění načtených dat. Je zde uvedená celá cesta, v mém případě se jednalo 

o místo na disku E. Nbchan udává informaci o počtu kanálů. Z xmin a xmax je zřejmé 

jak jsou data dlouhá, číselná hodnota je uvedená v sekundách. V poloţce data jsou 

uloţena naměřená data z jednotlivých kanálů. Vypsání dat je umoţněno příkazem: 

>> EEG.data 

V tomto konkrétním případě se jedná o čtyři načtené kanály, které představují 

čtyři řádky a dat o délce 141980, ty představují sloupce (viz obrázek 6.3). 

 

Obrázek 6.3: Ukázka vypsání části EEG dat ze čtyř kanálů 

Velikost načtených dat je také moţné jednoduše zjistit v příkazovém okně 

zadáním příkazu: 

>> size(EEG.data)  

a k jednotlivým kanálům se následně přistupuje přes různé modifikace příkazu: 

>> EEG.data(1,:) 

Takto zapsaný příkaz zobrazí veškerá data, která náleţí prvnímu kanálu, tzn. data 

z elektrody P3. Která data se zobrazí, záleţí na uvedených argumentech v závorce. 

Dvojtečka značí všechna dostupná data. 
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6.3 Rozšíření EEGLABu  

Velkou výhodou EEGLABu je jeho rozšiřitelnost. Na internetových stránkách 

<http://sccn.ucsd.edu/eeglab/> jsou dostupné nové pluginy, umoţňující rozšíření 

stávajících funkcí. Dále existuje moţnost vytvořit si vlastní plugin, který následně 

disponuje funkcionalitou poţadovanou od daného uţivatele.  

Při tvorbě nových pluginů je velice výhodné pouţívat pop funkce. Pouţít lze pop 

funkce, které jsou jiţ součástí EEGLABU nebo je moţnost si je také nově vytvořit. 

6.3.1 Pop funkce 

V anglické literatuře je označována jako pop_function. Jedná se o funkce, které 

berou jako vstupní parametr EEG. Standardně jsou pojmenovány jako pop_ a následně 

je za podtrţítkem uveden název funkce, která se má vykonat.  

Vytvoření pop funkce je velice snadné. Následující příklad obsahuje jednoduchou 

pop funkci pop_vypis, která načte EEG data a zobrazí řetězec „Text“.  

function [ EEG, com ] = pop_welch( EEG ); 

com = ' '; 

 

disp('Text'); 

 

end 
  

 

Nově vytvořenou pop funkci je nutné uloţit jako Matlab soubor (pop_function.m) 

do podadresáře EEGLABu. Příklad cesty:  

E:\eeglab_current\eeglab13_1_1b\functions\popfunc\ 

Následně je moţné takto uloţené funkce vyvolat přímo z Matlabu z příkazového 

okna. Další moţností je vyvolání z menu EEGLABu. Například vyvolání funkce 

pro načtení datového souboru z nabídky EEGLABu přes File > Load existing dataset je 

totoţné jako vyvolání funkce z příkazového okna příkazem:  

>> EEG = pop_loadset; 

http://sccn.ucsd.edu/eeglab/
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Funkce můţe poţadovat od uţivatele zadání dalších parametrů, bez kterých nelze 

provést další operace a zpracování dat. Menu EEGLABu lze dle potřeby rozšířit 

vytvořením pluginů, do kterých lze pop funkce integrovat (viz. dále). 

6.3.2 Plugin 

Pro vytvoření rozšíření (zásuvný modul – anglicky: plug-in) je potřeba vytvořit 

funkční Matlab soubor. EEGLAB automaticky začlení všechny pluginy, které jsou 

pojmenované 'eegplugin_[funkce_pluginu.m] ' a současně jsou uloţené v hlavním 

adresáři EEGLABu, případně v podsloţce 'Plugin '. Plugin je detekován při spuštění 

EEGLABu, tzn. přidání nového pluginu se projeví aţ při jeho novém spuštění. 

Plugin musí obsahovat následující tři argumenty: 

>>eegplugin_funkce (fig, try_strings, catch_strings); 

První argument 'fig ' je hlavičkou hlavního okna EEGLABu, druhý argument 

'try_strings' obsahuje příkazy, které kontrolují vstupní data a třetí argument 

'catch_strings' obsahuje příkazy pro zpracování chyb. 

Příklad moţných variant pro druhý argument 'try_strings': 

 try_strings.no_check : kontrola, zda jsou data neprázdná 

 try_strings.check_cont: kontrola, zda jsou data spojitá 

Příklad jednoduchého pluginu „Plot channel“ do menu „Plot“ pro vykreslení prvního 

z načtených kanálů:  

% eegplugin_plotchannel() – plugin pro vykreslení kanálu  

function eegplugin_erp( fig, try_strings, catch_strings); 

% vytvoření menu, findobj najde v menu objekt 'plot', přidá se položka 'Plot channel' 

plotmenu = findobj(fig, 'tag', 'plot');  

% přiřazení funkce, která vykreslí první načtený kanál EEG dat  

uimenu( plotmenu, 'label', 'Plot channel', ... 

    'callback', 'figure; plot(EEG.data(1,:));'); 
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V mojí práci vyuţívám členění na podmenu (viz obrázek 6.4) s voláním nově 

vytvořených pop funkcí: 

% eegplugin_metody()  

function eegplugin_metody( fig, try_strings, catch_strings); 

plotmenu = findobj(fig, 'tag', 'plot'); 

submenu = uimenu( plotmenu, 'label', 'Methods of analysis');  

% přiřazení pop funkcí 

welch = [ 'EEG = pop_welch(EEG)' ];  

wavelet = [ 'EEG = pop_sin(EEG)'];  

% přidání dvou podmenu – pro výkonovou spektrální hustotu a pro waveletovou 

transformaci 

uimenu( submenu, 'label', 'Power spectral density - Welch', 'callback', welch); 

uimenu( submenu, 'label', 'Wavelet transform', 'callback', wavelet); 

 

 

Obrázek 6.4: Přidaná položka Methods of analysis a její podmenu 
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7 Metody pro analýzu záznamů 

Jako metodu pro analýzu záznamu jsem zvolila výkonovou spektrální hustotu. 

Navíc jsem poté ještě vyzkoušela waveletovou transformaci. Pro obě tyto metody je 

nejprve nutné načíst si signál, který chceme analyzovat. 

Pro waveletovou transformaci se jednoduše načte signál pomocí File > Import 

data > Using the FILE-IO interface. Po vybrání poţadovaného souboru .eeg nebo .vhdr 

se zobrazí nabídka, ve které uţivatel upřesní, které kanály EEG dat chce analyzovat 

(viz obrázek 7.1). Pro detekci SSVEP je vhodné sledovat elektrody P3, P4, O1 a O2, 

kterým odpovídají kanály 7 - 10. Dále je uţivatel vyzván k pojmenování tohoto signálu. 

Na pojmenování signálu o těchto čtyřech kanálech nezáleţí. 

 

Obrázek 7.1: Načtení kanálu 7, 8, 9 a 10 z EEG signálu 

Data pro výkonovou spektrální hustotu načteme stejně jako v předcházejícím 

případě, je však nutné je ještě upravit. Jiţ bylo řečeno, ţe naměřená data obsahují 

minutu klidového záznamu a minutu stimulovaného záznamu. Protoţe budeme 

potřebovat klidové a stimulované záznamy vzájemně porovnat, je nutné záznamy 

rozdělit.  

Z načteného záznamu v nabídce Edit > Select data vybereme časový rozsah 

(Time range) v sekundách. Při analyzování dat jsem konkrétně pracovala s výběrem dat 

10 – 25 sekund klidového záznamu a 75 – 90 sekund stimulovaného záznamu. Tyto 

časové úseky jsem vybrala z toho důvodu, ţe na okrajích mohla být data zkreslená. 

Pro porovnání klidového a stimulovaného záznamu je nezbytně nutné, aby takto 

vybrané záznamy byly stejně dlouhé. Dále je potřeba vybraný klidový záznam uloţit 
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jako „signal_klid“ a vybraný stimulovaný záznam jako „signal_stimul“. S takto 

pojmenovanými soubory se v programu nadále pracuje. 

7.1 Výkonová spektrální hustota 

Nejprve jsem si rozdělená a uloţená data načetla ze souboru pomocí pop funkce. 

Následně jsem data přiřadila proměnným: 

klid = pop_fileio('signal_klid.set'); %načtení klidového signálu 

stimul = pop_fileio('signal_stimul.set'); %načtení simulovaného signálu 

Pro odhad spektrální výkonové hustoty jsem zvolila Welchovu metodu. Pouţila 

jsem následující syntaxi: 

[pxx, f] = pwelch(x, window, noverlap, f, fs); 

Vstupní argumenty: 

 x – označuje vstupní signál. V mém případě jsou vstupním signálem nejprve 

klidová data:  klid.data(:,:); , poté stimulovaná data:  stimul.data(:,:); . 

 window – označuje okno. Pouţívám Hammingovo okno, window = 

hamming(2048);  

 noverlap – vyjadřuje překrývání vzorků. Defaultně je při prázdném argumentu 

nebo jeho vynechání nastaveno 50% překrytí vzorků. V mojí práci vyuţívám 

defaultní nastavení 

 f – označuje cyklické frekvence. Frekvence jsou v cyklech za jednotku času. 

Časová jednotka je daná vzorkovací frekvencí fs 

 fs – označuje vzorkovací frekvenci. Pokud je zadána hodnota fs, frekvenční osa je 

v Hz, v opačném případě je osa v π × rad/s. V mém případě byla vzorkovací 

frekvence 1 kHz, tzn. 1000 Hz 

Výstupní argumenty: 

 pxx – označuje odhad výkonové spektrální hustoty 

 f – označuje cyklické frekvence 
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Pro vykreslení odhadu výkonové spektrální hustoty u obou signálů (klidový signál 

označen modře, stimulovaný červeně) a jejich přiblíţení (viz obrázek 7.2) jsem pouţila: 

plot(f,10*log10(pxx1), 'b-', g,10*log10(pxx2), 'r-' ); 

axis ([0 20 -4 22]); 

 

Obrázek 7.2: Odhad výkonové spektrální hustoty Welchovo metodou u klidového i 

stimulovaného signálu 

Následně jsem si vypočetla, kterému vzorku odpovídá hodnota 8 Hz. V případě 

pouţití Hammingova okna o velikosti 2048 a vzorkovací frekvenci 1000 Hz a jejich 

vydělení 1000/2048 jsem zjistila, ţe velikost jednoho okna odpovídá přibliţně 

0,488 Hz. Z toho vyplývá, ţe 8 Hz spadá do 17tého vzorku.  

Hodnotu odpovídající 8 Hz u klidových dat jsem spočítala jako průměr hodnot 

v 7,5 Hz, 8 Hz a 8,5 Hz a uloţila ji do proměnné avg8. Poté jsem vzala šest hodnot 

klidových dat z okolí 8 Hz (v 6 Hz, 6,5 Hz, 7 Hz, 9 Hz, 9,5 Hz, 10 Hz) a vypočítala 

jejich průměrnou hodnotu avg. Z poměru hodnot avg8 a průměrných hodnot avg jsem 

dále vypočítala jejich vzájemný poměr avg8/avg.  

Sekvence odpovídajícího kódu pro klidová data: 

%poměr v 8 Hz a okolí v klidovém stavu 

i6 = hodnota_klid (13, 2) 

i6_5 = hodnota_klid (14, 2) 
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i7 = hodnota_klid (15, 2) 

i7_5 = hodnota_klid (16, 2) 

i8 = hodnota_klid (17, 2) 

i8_5 = hodnota_klid (18, 2) 

i9 = hodnota_klid (19, 2) 

i9_5 = hodnota_klid (20, 2) 

i10 = hodnota_klid (21, 2) 

%průměr hodnot v 8 Hz 

avg8 = (i7_5 +i8 + i8_5) / 3     

%průměr hodnot v okolí 8 Hz 

avg = (i6 + i6_5 + i7 + i9 + i9_5 + i10) / 6     

%poměr v 8 Hz a okolí v klidovém stavu  

pomer_klid = avg8/avg  

Ten samý postup jsem aplikovala i na stimulovaná data. Jako výsledek jsem tedy 

získala dva poměry hodnot v 8 Hz a okolí (pro pomer_klid a pomer_stimul). 

Pro stimulovaná data logicky platí, ţe by vypočítaný poměr měl být větší, neţ je 

vypočítaný poměr u dat klidových. Metodu jsem ověřila na záznamech získaných 

z měření. 

Souhrnný přehled vypočtených hodnot je uveden v kapitole 8 (Dosaţené 

výsledky).  

7.2 Waveletová transformace 

Navíc jsem jako druhou metodu pro analýzu záznamů zvolila spojitou 

waveletovou transformaci 1-D. Zkusila jsem si vytvořit zkušební signál, na kterém 

by byla snadno odlišitelná frekvence 8 Hz. Nejprve jsem vytvořila signál, který na jedné 

třetině své délky má frekvenci 8 Hz (viz obrázek 7.3).  

Sekvence kódu obsahující vytvoření sinusové vlny o frekvenci 8 Hz a její následné 

vykreslení:  

sin_8Hz = 7*sin(50.2*tt);  

s_klid = 4*sin(0*tt);  
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%sinusová vlna složená z klid, klid, 8 Hz 

s = [s_klid s_klid sin_8Hz]; 

figure(3) 

subplot(3,1,1);  

plot(s);  

title('Sinusova vlna obsahujici frekvenci 8 Hz'); 

axis ([0 1300 -1.1 1.1]); 

Následně jsem vytvořila druhý signál, který obsahuje součet třech sinusových vln 

o různých frekvencích, konkrétně 2 Hz, 5 Hz a 3 Hz (viz obrázek 7.3).  

%sinusová vlna složená z různých sinů - frekvence 2Hz, 5Hz, 3Hz 

sin_mix = 4*sin(12.6*tt) + 2*sin(31.4*tt) + 3*sin(18.8*tt); 

Tyto dva vytvořené předchozí signály jsem sečetla (viz obrázek 7.3). Tím jsem 

získala výsledný signál, který analyzuji pomocí CWT. 

 

Obrázek 7.3: Vytvořený signál obsahující frekvenci 8 Hz, signál složený z různých 

sinusových funkcí o různé frekvenci a výsledný signál daný součtem signálů předchozích 
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Pro analýzu CWT 1-D jsem pouţila následující syntaxi: 

coefs = cwt (x, scales‚ 'wname', 'plot');  

Vstupní argumenty: 

 x - označuje vstupní signál. V mém případě se jedná o signál celk, který 

představuje výsledný zkušební signál daný součtem signálů výše uvedených. 

 scales – označuje škálu na ose y. Zvolila jsem rozsah 1:128. 

 wname – reprezentuje vlnkovou funkci, která má být pouţita. Zvolila jsem 

wavelet db7 z důvodu, ţe má podobný průběh jako sinus. 

 plot – není povinný parametr, zajišťuje pouze vykreslení (viz obrázek 7.4). 

 

Obrázek 7.4: Absolutní hodnoty koeficientů CWT 

Vzhledem k tomu, ţe osa y (scales) není uvedena v Hz, musela jsem zjistit, která 

hodnota scales odpovídá poţadované frekvenci 8 Hz. K tomu jsem pouţila následující 

část kódu: 
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%perioda vzorkování (1/1000) 

delta = 0.001; 

f = scal2frq(scales,'db7',delta); 

per = 1./f;  

%zobrazení odpovídajících hodnot scale, frekvence a perioda 

disp ('Scale Frequency Period') 

disp([scales' f' per']) 

Zjistila jsem, ţe frekvenci 8 Hz odpovídá zhruba scale 87.0000 na ose y 

(viz obrázek 7.5). Bohuţel zde ani v blízkém okolí se nevyskytuje ţádná abnormalita 

nebo odlišnost (viz obrázek 7.4), kterou bych mohla hledat v reálném signálu.  

 

Obrázek 7.5: Několik vybraných hodnot pro scale, frekvenci a periodu 
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8 Dosažené výsledky 

Implementovanou metodu odhadu výkonové spektrální hustoty pomocí Welchovy 

metody jsem vyuţila při analýze experimentálně naměřených dat od 3 osob, z toho 

jedna osoba byla měřena dvakrát v různých časech. U měření 1, 2 a 3 jsem záznamy 

získala při stimulaci frekvencemi 5, 7, 9 a 11 Hz a u měření 4 při stimulaci frekvencemi 

8, 9, 10, 14 a 15 Hz. Při analýze jsem pracovala s úsekem 10 – 25 sekund záznamu 

pořízeného v klidu a s úsekem 75 – 90 sekund záznamu pořízeného při stimulaci.  

Výsledky jsou uvedené v následující tabulce 8.1, přičemţ mezi nejdůleţitější 

směrodatné výsledky patří sloupec s výsledným poměrem dat při stimulaci a sloupec 

s výsledným poměrem dat u záznamu pořízeného v klidu.  

Některé hodnoty vypočtené při analýze nejsou směrodatné, a proto nemělo smysl 

pro ně uvádět poměr. Jedná se o hodnoty záporné, které vznikly z toho důvodu, ţe jsou 

průměrné hodnoty v 8 Hz a průměrné hodnoty v okolí 8 Hz vypočtené odhadem 

výkonové spektrální hustoty Welchovo metodou v jednotkách dB.  

Výsledky také mohly být ovlivněny fyziologickými vlastnostmi daných subjektů. 

Existují lidé, kteří na stimulaci některými frekvencemi nereagují nebo reagují hůře. 

Měřená osoba můţe v okolí testované frekvence vykazovat mnohem silnější základní 

mozkovou aktivitu a změny způsobené stimulační frekvencí pak nemusí být patrné. 
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 Hodnota stimulovaného 

záznamu [dB] 

Hodnota klidového 

záznamu [dB] 

v 8 Hz 

(průměr) 

okolí  

8 Hz 

(průměr) 

poměr 
v 8 Hz 

(průměr) 

okolí  

8 Hz 

(průměr) 

poměr 

Mereni_1/klid_5Hz.eeg 1,9943 0,4343 4,5915 0,9216 0,5133 1,7954 

Mereni_1/klid_7Hz.eeg 0,6643 -1,6661 - 0,2087 1,1851 0,1761 

Mereni_1/klid_9Hz.eeg 0,6289 0,7324 0,8586 2,4350 0,8746 2,7842 

Mereni_1/klid_11Hz.eeg -0,9958 0,0778 - 0,5402 0,7244 0,7457 

Mereni_2/klid_5Hz.eeg 0,3450 0,4098 0,8418 3,2671 3,7757 0,8653 

Mereni_2/klid_7Hz.eeg 2,8811 2,1120 1,3641 3,7088 3,2194 1,1520 

Mereni_2/klid_9Hz.eeg 0,4245 1,3115 0,3237 -0,3571 0,1508 - 

Mereni_2/klid_11Hz.eeg -1,6709 1,2427 - 0,5720 1,2243 0,4672 

Mereni_3/5Hz.eeg 7,2764 8,9099 0,8167 0,9216 0,5133 1,7954 

Mereni_3/7Hz.eeg 6,9851 8,1495 0,8571 0,2087 1,1851 0,1761 

Mereni_3/9Hz.eeg 7,1075 7,0647 1,0060 2,4350 0,8746 2,7842 

Mereni_3/11Hz.eeg 7,6485 8,4209 0,9083 0,5402 0,7244 0,7457 

Mereni_4/klid_8Hz.eeg 2,0696 0,8889 2,3283 1,1019 0,5457 2,0192 

Mereni_4/klid_9Hz.eeg -2,1784 -1,5191 - 2,2570 1,1548 1,9544 

Mereni_4/klid_10Hz.eeg 0,6130 1,7663 0,3470 5,1731 3,5961 1,4385 

 Mereni_4/klid_14Hz.eeg 0,3608 -0,7819 - -1,8854 -0,7479 - 

 

 

 

 

Mereni_4/klid_15Hz.eeg -0,6214 0,7497 -0,8290 0,8996 -0,9177 -0,9803 

 

Tabulka 8.1: Dosažené výsledky 
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9 Závěr 

V bakalářské práci jsem pracovala především se SSVEP potenciály a jejich 

detekcí v EEG signálech. Toto téma spadá do oblasti neuroinformatiky, jejíţ základy 

bylo nutné pečlivě prostudovat. Na základě získaných znalostí bylo moţné vybrat 

vhodné nástroje k analýze EEG zabývající se detekcí SSVEP potenciálů. 

Výsledkem mojí práce je zásuvný modul do EEGLABu, obsahující vhodnou 

metodu pro analýzu záznamů dostupných na KIV.  

Metodu zaloţenou na odhadu výkonové hustoty jsem otestovala na reálných 

experimentálně naměřených datech. U některých dat byl dle mého předpokladu 

zaznamenán větší poměr v případě stimulace. Předpokládám, ţe u zbylých dat ovlivnily 

analýzu fyziologické vlastnosti daných subjektů. Existují totiţ lidé, kteří na stimulaci 

nereagují nebo reagují hůře, proto u nich nemusí k ţádným větším změnám v daném 

poměru docházet.  

Navíc jsem se jako další metodu pro analýzu signálu rozhodla vyzkoušet 

waveletovou transformaci. Jelikoţ jsem předpokládala zhoršené podmínky pro detekci 

SSVEP u reálně naměřených dat, vytvořila jsem zkušební signál, na kterém by bylo 

jednoduché rozdíly přítomné při frekvenci 8 Hz rozpoznat. Chtěla jsem takto 

detekovaných rozdílů v dané frekvenci u zkušebního signálu vyuţít jako vzoru pro data 

reálná. Při snaze analyzovat uměle vytvořený signál pomocí 1-D CWT však nastaly 

komplikace. Snaţila jsem se detekovat jakékoliv odlišnosti na frekvenci 8 Hz. To se mi 

bohuţel nepodařilo.  

Dalším moţným rozšířením nebo námětem pro další práci by bylo realizovat 

klasifikaci záznamů, a to na základě vhodného stanovení prahu mezi poměrem 

u stimulovaného záznamu a poměrem u klidového záznamu. Při klasifikaci by bylo 

moţné jednoznačně určit, zda byl subjekt na daném časovém intervalu stimulován 

či nikoliv a tuto informaci vyuţít např. v systémech rozhraní mozek počítač (BCI).  
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Zkratky 

SSVEP Ustálené vizuální evokované potenciály 

EEG Elektroencefalogram 

EP Evokované potenciály 

VEP Vizuální evokované potenciály 

BAEP Sluchové kmenové evokované potenciály 

SEP Somatosenzorické evokované potenciály 

MEP Motorické evokované potenciály 

ERP Endogenní kognitivní evokované potenciály 

FT Fourierova transformace 

DFT Diskrétní Fourierova transformace 

FFT Rychlá Fourierova transformace 

PSD Power Spectral Density, spektrální výkonová hustota 

STFT Krátkodobá Fourierova transformace 

WT Waveletová transformace 

CWT Spojitá waveletová transformace 

DWT Diskrétní waveletová transformace 
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Příloha A 

 

Obrázek A.1: Wavelet typu Daubechies různého stupně [14] 
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Obrázek A.2: Wavelet typu Symlets různého stupně [14] 
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Příloha B 

Uživatelská příručka 

B.1 Instalace EEGLABu 

EEGLAB lze spustit v Matlabu v5 a vyšší (doporučená je verze 7) v systémech 

Linux, Unix, Windows i Mac OS X.  

Instalace pro Windows: 

1) Je nutné staţený EEGLAB rozbalit. 

2) Pro pouţívání EEGLABu se k němu v Matlabu musí nastavit cesta: 

File > Set path > Add Folder..  

a následně se zvolená cesta uloţí pomocí Save (viz obrázek 6.1). 

 

Obrázek B.1: Nastavení cesty k adresáři EEGLABu 

3) Zadáním příkazu >>eeglab  do příkazového řádku Matlabu se EEGLAB spustí. 

Pokud ne, tak s největší pravděpodobností byla nastavena nesprávná cesta 

k adresáři EEGLABu. Doporučuji nastavit cestu znovu.  
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B.2 Instalace pluginu a pop funkcí 

Pro správnou funkci rozšíření je nutné vloţit vytvořené funkce pop_psd a pop_wt 

do adresáře EEGLABU, pro verzi v13.1.1 do \eeglab13_2_2b\functions\popfunc\. 

Stejně tak plugin eegplugin_menu je nutné vloţit do adresáře EEGLABu, pro verzi 

v13.1.1 do \eeglab13_2_2b\plugins\. Aby se přidání funkcí a pluginu projevilo 

a uţivatel je mohl pouţívat, je nutné spustit EEGLAB znovu.  

B.3 Základní ovládání EEGLABu 

Po spuštění EEGLABu se objeví GUI. Momentálně jsou aktivní pouze dvě 

poloţky: File a Help. Pro načtení souboru se zvolí poloţka File > Import data > Using 

the FILE-IO interface. Následně uţivatel vybere poţadovaný soubor (typu .eeg nebo 

.vhdr), který chce otevřít. Zobrazí se nabídka, ve které má uţivatel moţnost vybrat jen 

některé kanály, případně vybrat rozsah dat. Po potvrzení tohoto výběru uţivatel data 

pojmenuje a můţe s nimi v EEGLABu pracovat. 

Vytvořený plugin se nachází v menu Plot > Methods of analysis. Je zde na výběr 

ze dvou moţností. První je odhad výkonové spektrální hustoty pomocí Welchovy 

metody Power spectral density – Welch. Druhou moţností je waveletová transformace 

Wavelet transform.  

Momentálně načtená data jsou ihned připravená k analýze waveletovou 

transformací.  

Pro odhad spektrální hustoty Welchovo metodu je nutné ještě data rozdělit 

na signál zaznamenaný v klidu a signál zaznamenaný při stimulaci. Výběr dat je 

umoţněn v nabídce Edit > Select data. Poţadovaný časový úsek z dat se uvede 

do poloţky Time range ve formátu [min max] v sekundách. Výběr se potvrdí OK. 

V následujícím okně uţivatel zaškrtne poloţku Save it as file a zadá název nového 

úseku dat (data v klidu je nutné jednotně pojmenovat jako signal_klid a stimulovaná 

data signal_stimul). Takto připravená data jsou vhodná pro odhad spektrální hustoty 

Welchovo metodou. 

 


